
ImagView Help Contents:

Button functions

Image sources

Presentation Hint

Security

Packing List

Copyright and Warranty Notices

Ordering Information

Other BCP Products:

FileView

DiskGard

Acknowledgements:
Kodak is a trademark of Eastman Kodak Company. Microsoft is a registered trademark of 
Microsoft Corporation. Visual Basic is a trademark of Microsoft Corp. All other registered and 
unregistered trademarks are the property of their respective owners.



Button Functions

About - displays program information.
Help - displays this file.
S-Saver - displays the screen saver menu. 

The 'Transition Speed' menu enables you to nominate the speed at which each new
slide overwrites the previous one. 
The 'New Slide Every' menu enables you to nominate the rate at which slides are 
displayed.
When the screen saver is running, the command buttons and mousepointer will not 
be visible. To restore them, press any key or click the mouse button once.

Setup - displays the slideshow configuration screen.
Enter your password to gain access to the configuration screen. Please ensure that 
your password is kept in a secure place as it cannot be changed. If you loose your 
password, BC Publishing will send a copy to you on request, provided that your 
signature matches that of the current registered owner. If you assign ownership of 
your program to another person, please register the change of ownership by 
sending the signatures of both the previous and new owner to us.
Instructions for configuring your slideshow are included on the Setup screen. Each 
time you reconfigure 'ImagView', the previous configuration is overwritten.

Hide - hides the command buttons and the mousepointer. 
To restore the buttons and cursor, press any key or click the mouse button once.

First - displays the first image.
Back - displays the previous image.
Next - displays the next image.
Last - displays the last image.
Exit - close slideshow.



Image Sources

Imagview will display any image created in the Windows bitmap format (those with a .BMP 
filename extension), such as those created with 'Microsoft® Windows Paintbrush'.

Bitmap images can be obtained from many sources:

a) create your own images using a paint package such as 'Microsoft® Windows Paintbrush'. If 
your paint package does not save files in the .BMP format, the images can be saved 
as .PCX files and converted to .BMP format with 'Microsoft® Windows Paintbrush' (use 
Save As in the File menu).

b) there is a vast amount of clip art available with the various paint, presentation, desktop 
publishing and word processing software packages produced by a whole host of software 
houses. Each vendor tends to use a proprietary format for their clipart and many formats 
cannot be 'pasted' to Microsoft® Windows Paintbrush. However, there is an easy 
alternative. Open the particular application and load the clipart you wish to use with 
'ImagView'. Ensure that the image is fully visible within the application's window. Now hold 
down the ALT key and press the Print Screen key (this copies an image of the current 
window into the clipboard). Open Microsoft® Windows Paintbrush and use Paste from the 
Edit menu to copy the contents of the clipboard into Paintbrush. Then use cut and paste to 
isolate the part of the image you wish to keep. Note that clipart is subject to copyright. You 
should check that you are not breaching your license agreement by copying clipart in this 
way.

c) for best quality images, use 'KODAK™ Photo CD'. Take photographs of your subjects and 
have KODAK™ develop them as 'Photo CD' image files stored on CD-Rom. The image files
can then be converted to .BMP format using a package such    as 'KODAK™ PhotoEdge' (or
see item [b] above). If you do not have a CD-Rom drive, most desktop publishing services 
will be able to assist.

d) choose images from the many clipart packages available from computer retailers.

e) use desktop or hand scanners to capture images.

f) fax drawings to a computer connected to a fax/modem and then convert the images to .BMP
format.

Note: When you configure 'ImagView', the program creates it's own image files which are 
named: '#BCPx.IMG', where 'x' is a number corresponding to the relative position of the image 
within your slideshow. When reconfiguring 'ImagView', the .IMG files cannot be re-used as part 
of the configuration as they are not bitmap files. If you wish to include an existing 'ImagView' 
image in a new configuration, the original bitmap (.BMP) file should be included in the setup file
list.



Presentation Hint

'ImagView' will automatically centre images on the screen. 

When you create an image with 'Microsoft® Windows Paintbrush', the program saves the entire
screen area as part of the image, even if your artwork occupies only a small part of the screen. 
When 'ImagView' displays such an image, it displays the entire image, irrespective of where in 
the image your artwork is located. 

To ensure that your artwork is centred on the 'ImagView' screen, use the Cut-Out tool in 
'Microsoft® Windows Paintbrush' to define a rectangle with your artwork centred within the 
rectangle. Then select Copy To from the Edit menu to copy the cutout area to it's own file. The 
image thus created will be the same size as the cutout area and your artwork will be centred 
within the image. 'Imagview' will in turn centre this image on the screen.



Security

'ImagView' performs numerous checks which determine if the original configuration of the 
slideshow might have been tampered with. If a discrepancy is detected, the slideshow may be 
disabled. Missing or damaged image files will also generate error messages. The program will 
generally provide a message explaining why the slideshow has been disabled. If you are 
unable to correct the problem, it may be necessary to contact the author of the slideshow for 
another copy.



Packing List

When ImagView is installed on a computer, the following files are required:

1. ImagView.Exe - the program file. For ease of use, install ImagView in it's own directory, 
e.g., C:\IMAGVIEW.

2. VBRun300.Dll - this file can be installed in the same directory as the program, but ideally, it
should be installed in the directory C:\WINDOWS\SYSTEM. If this file was not included on 
your distribution disk, it can be obtained from most bulletin boards.

3. CMDialog.Vbx - this file can also be installed in the same directory as the program, but 
once again, it should be installed in the directory C:\WINDOWS\SYSTEM.

4. ImagView.Ini - this file should be installed in the same directory as the program file.
5. #BCPx.Img - the image files used by ImagView are all named in this way. In place of the 'x'

in each filename will be a number which represents the relative position of the image in the 
slideshow. All image files should be installed in the same directory as the program file.

6. ImagView.Hlp - the file you are currently reading. This file should be installed in the same 
directory as the program file.

Note that ImagView will most probably not work if ImagView.Ini or any of the image files has 
been tampered with. This feature has been built into the program to prevent unauthorised 
changes being made to your slideshows.



Copyright and Warranty Notices

End User License Agreement:
When you purchase a copy of 'ImagView.Exe' and it's associated password and files 
(hereinafter collectively referred to as 'ImagView') from BC Publishing, you become a 
'registered password owner'. Use of the ImagView password is restricted to the 'registered 
password owner'. As a 'registered password owner', you have the right to use the password to 
configure a single copy of 'ImagView' on a single terminal connected to a single computer (i.e., 
with a single CPU). You may not use the password to configure the program on more than one 
computer or terminal at the same time.

'Imagview' is owned by BC Publishing and is protected by the copyright laws of Australia and 
international copyright treaties. You must treat 'ImagView' like any other copyrighted material 
(e.g., a book or musical recording). You may not reverse engineer, decompile, or disassemble 
'ImagView'. You may not rent or lease 'ImagView', but you may transfer ownership of 
'ImagView' on a permanent basis, but in so doing, you relinquish your right to use the password
to configure 'ImagView'. Your right to transfer ownership of your password is conditional upon 
your obtaining from the transferee an agreement to accept the terms of this end user license 
agreement.

You have the right to distribute unlimited copies of slideshows you produce with 
'ImagView', provided that your password is not distributed with those slideshows. No 
royalties or fees of any kind are payable for slideshows you distribute.

The Visual Basic™ source code for ImagView is protected by the copyright laws of 
Australia and international copyright treaties. It may not be distributed electronically, or 
in printed form or on any type of data storage medium. It is not shareware and may not 
be placed on computer bulletin boards.

You may not in any way alter or recompile the Visual Basic™ source code for ImagView.

This license and your right to use 'ImagView' automatically terminates if you fail to comply with 
any provision of this agreement.

Warranty: 
The original diskette containing 'ImagView' is warranted for a period of 30 days from the date of
purchase to be free from physical defects. If you provide written notification to BC Publishing 
within the warranty period of any such defects, BC Publishing will at it's option replace the 
diskette (shipping costs are not refundable). 

The sole remedy for breach of this warranty is limited to replacement of a defective diskette 
and does not include any other kinds of damage.

Except as specifically provided above, 'ImagView' is provided "AS IS" without any warranty of 
any kind as to the accuracy or completeness of the disks or the computer programs and files 
included in 'ImagView', and without any warranty as to the result to be obtained from using 
'ImagView'. BC Publising will not be responsible for any claims attributable to errors, omissions,
or other inaccuracies in the computer programs, files or documentation of 'ImagView'. The 
entire risk as to the results and performance of 'ImagView" is assumed by the user. BC 
Publishing does not make any representations or warranties, either express or implied, with 
respect to 'ImagView' or the disk containing it. In no event shall BC Publishing be liable for any 
damages whatsoever (including, without limitation, damages for loss of business profits, 
business interruption, loss of business information, or other pecuniary loss) arising out of the 
use of or inability to use 'ImagView', even if BC Publishing has been advised of the possibility 



of such damages.



Ordering Information

Price: $35 (Australian). Overseas buyers, please add $5 if air freight is required. Note that 
surface post may take several weeks.

And for those interested in learning programming, the fully commented Visual Basic™ source 
code for 'ImagView' will be included in the registered software package. The source code 
includes the following Windows API calls: Bitblt, Showcursor and Winhelp. Some of the original 
ImagView source code will not be included in the package. For example, in order to minimize 
the risk of unauthorized changes being made to slideshows, the code for creating the 
proprietary image files will not be included. Instead, the code will show how to use ImagView to
display ordinary bitmap files.

Select Print Topic from the File menu to print this order form.

Name:

Address:

Company Name (if applicable):

Job Title (if applicable):

Your Signature 
(all future correspondence regarding your password must include this signature)
Post To: BC Publishing   (BN 4797073)  , GPO Box 2996, Brisbane, Australia. 4001.  



FileView

'FileView' provides a revolutionary new way of accessing text files.

The program makes it feasible for an organization to keep it's entire information system in text 
files. The system can therefore be installed and maintained by unskilled personnel at minimal 
cost. Furthermore, 'FileView' has a clever new interface which even the most inexperienced 
user can learn in just a few minutes. 

If you have a large number of users, requiring access to a large volume of frequently-changing 
information, 'FileView' is the low cost solution for you.

There are many imaginative ways in which 'FileView' can be used. For example, one 
organization uses 'FileView' to create catalogues for it's clients. Product descriptions and prices
are stored in text files and then 'FileView' is configured to provide organized access to the 
information.

But it is not just the corporate user who will benefit from 'FileView'. The individual user can use 
'FileView' to organize his or her desktop. Use 'FileView' as a diary, a desk organizer, a phone 
directory, or as an organizer for your personal correspondence. Programmers can use 
'FileView' for fast access to their source code. Clipping agencies can use 'FileView' to 
catalogue their press clippings. Think of a task requiring fast, orderly access to information, and
'FileView' can probably be configured to perform it.

'FileView' uses your text files organized into categories which you name. It can therefore be 
used anywhere in the world, no matter what the national language.

For those interested in learning programming, the fully commented Visual Basic™ source code 
for 'FileView' will be included in the registered software package. 'FileView' includes a DLL, 
Shilo.Dll, which filters null characters from strings, thus enabling VB text boxes to display the 
contents of files created with word processors. The source code shows you how to call the DLL
from within VB programs. You may distribute the DLL royalty-free with your own VB programs. 
For those interested in C/C++, the source code for the DLL is also included.

To obtain an evaluation copy of 'FileView', check your local bulletin board. If you are unable to 
obtain a copy, send a blank disk (720K minimum) plus $5 post and packing to BC Publishing 
and we'll send you a copy .

If you then decide to purchase a registered copy, prices are as follows:
 Single User - $35 (Aus).

Site License - $100 (Aus) - unlimited copies at one physical address.
Corporate License (Multi-Site or Network) - by negotiation.
Overseas buyers add $5 if air freight required. Note that surface mail may take 

several weeks.

BC Publishing
GPO Box 2996
Brisbane
Australia. 4001



DiskGard

'DiskGard' searches PC drives for unauthorised .EXE, .COM and .BAT files. 

Users may unintentionally install illegal software on their PC's without realising they are 
exposing their employer to significant penalties. 

Unauthorized software cannot be hidden as 'DiskGard' searches every drive from b: to z: (drive
a: is not included in the search as it will hold a disk containing configuration information for 
'DiskGard').

When you order a registered copy of 'DiskGard' the fully commented Visual Basic™ source 
code is included in the package.

To obtain an evaluation copy of 'DiskGard', check your local bulletin board. If you are unable to 
obtain a copy, send a blank disk (720K minimum) plus $5 post and packing to BC Publishing 
and we'll send you a copy.

If you then decide to purchase a registered copy of the program, the price is as follows: $20 
(Aus). Overseas buyers add $5 if air freight required. Note that surface mail may take several 
weeks.

BC Publishing
GPO Box 2996
Brisbane
Australia. 4001


